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Overview of the SAS System Interface
The main SAS window contains all other SAS application windows. The main SAS

window is completely configurable, enabling you to use its features in a way that is
productive for you. Display 2.1 on page 27 shows the main SAS window as it appears
when you first start the SAS System. This section briefly describes the features of the
window.
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Display 2.1 The Main SAS Window
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Here are the primary components of the main SAS window:

menu bar
presents the menus that are available for the active SAS application window. As
you switch between application windows, the menu bar changes. Similarly, the
pop-up menus that appear when you click on the right mouse button inside a
window are specific for that window.

command bar
provides a way to quickly enter any SAS command. The command bar retains a
list of the commands that you enter. To repeat a command that you issued
previously, either type until the command appears in the command bar or select
the command from the drop-down list and click on the check mark button or press
ENTER. To switch the keyboard focus to the command bar, press F11 (the key that
is defined as COMMAND BAR).

toolbar
provides quick access to the commands that you issue most often. The toolbar is
completely configurable and can contain up to 30 tools. You can associate different
sets of tools with different SAS application windows. When you create a tool, you
specify the tool icon, the commands that are associated with the tool, the Help text
that is displayed on the status line, and the tip text. The bitmap browser provides
hundreds of images that you can use to represent your commands on the toolbar.

windowing environment
contains a workspace to open windows within the main SAS window. Certain
windows, such as windows that are used for navigation, can dock to left side of the
main SAS window when Docking View is enabled from the Preferences dialog
box. Windows that cannot dock to the main SAS window open to the right of the
docking area. For more information about using dockable windows, see “Using the
Docking View” on page 28.
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status line
contains a message area and the current folder for the SAS System. The message
area displays Help text for menus and tools, as well as messages that are specific
to SAS application windows. The current folder area displays the name of the
current working folder. To change the current folder, double-click on the current
folder area. For more information about changing the current folder, see
“Changing the SAS Current Folder” on page 42.

The status line can be enabled and disabled from the Preferences dialog box.
The message line and the current folder can be enabled and disabled from either
the Preferences dialog box or the status line pop-up menu.

Accessing SAS Commands, Tools, and Options from Menus
You can access SAS commands, tools, and options by selecting them from the menus

at the top of the main SAS window or by using pop-up menus within application
windows. The menus display options that are available in the active window. To access
a pop-up menu for a particular window, click the right mouse button anywhere within a
window. The pop-up menu that appears contains the menu items that are available in
that particular window.

Some SAS windows (such as the Explorer window) along with the main SAS window
can contain objects that have their own pop-up menus when you click on an object by
using the right mouse button. For example, the command bar, the toolbar, and the
status line each have a pop-up menu. In these windows, the pop-up menu that appears
is specific to the selected object.

Using the Docking View
The SAS System for OS/2 makes it easier for you to access files by using docking

view. When the docking view is enabled, certain windows are docked to the left side of
the main SAS window. These windows are typically used for navigation. When you
double click on an object in a docked window, a window that contains the object opens
in the right side of the main SAS window.

The docking view is enabled or disabled

� from the Preferences dialog box View page

� by entering the WDOCKVIEW command in the command bar.

Issuing the WDOCKVIEW command without any arguments toggles the docking view.
Each docked window has a tab at the bottom of the docking area for easy access to

the window. When the number of dockable windows is large enough so that you cannot
identify the tabs, a left and right arrow are displayed for you to navigate through the
docked windows.

Docked windows cannot be individually moved or resized. To enlarge or contract the
docking area, place the cursor over the split bar between the docking area and the
remaining portion of the main SAS window. Then click and hold down the left mouse
button. Move the mouse to the left or right to resize the docking area.

If you prefer to dock or undock individual windows, you can toggle the Docked menu
item by selecting

Window I Docked

For more information about docking or undocking all windows, see “View
Preferences” on page 45 and “WDOCKVIEW” on page 222.
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Learning about the Main SAS Window
To help you learn about the different parts of the main SAS window, the SAS

System provides different types of screen Help. The screen Help is either a message
that displays in the message area of the status line or a one- or two-word screen tip.
The message area descriptions are available for menus, the command bar, and items in
the toolbar. Screen tips are available for the command bar, toolbar buttons, the docking
area tabs, and the status line.

If you would like a description of a menu or a menu item, select the menu or menu
item, and hold down the mouse button. As the mouse pointer passes over the menu or
menu item, a description of the item displays in the message area of the status line.
For example, when you select the File pull-down menu, the status line displays the
words Perform file-related operations. As you drag the mouse to highlight the
items under the File menu, the message area displays a short description of each item.

When you place the cursor over a toolbar button, a screen tip displays by the icon
and a longer description displays in the message area.

For information about other parts of the main SAS window, such as the docking area
tabs and the status line, place the cursor over the item and hold it there for a second. A
one- or two-word screen tip will pop up.

If you customize the commands that are available from the toolbar, you can also
specify the descriptions (Tip Text and Help Text) that appear as screen tip Help and
the message in the message area. To learn more about changing the toolbar, see
“Customizing the Toolbar” on page 50.

To enable or disable command bar or toolbar screen tips, you can use either the Show
ScreenTips on toolbars option in the Customize dialog box Toolbars page or issue
the TOOLTIP command in the command bar. All other screen tips can be enabled or
disabled by using the ScreenTip option in the Preferences dialog box View page or by
using the WSCREENTIPS command. For more information on enabling and disabling
screen tips, see “Setting Session Preferences” on page 43, “Customizing the Toolbar” on
page 50, “WSCREENTIPS” on page 229, and “TOOLTIPS” on page 218.

Opening and Saving Files
You can open and save external files from any text editor window, such as the

Program Editor window. Some SAS windows, such as Log and Output, do not allow file
input; you cannot open files from these windows, but you can save the window contents
to external files. If you would like the default folder for the Open and Save As dialog
boxes to be the current working folder and not the SASUSER folder, you can use the
SASINITIALFOLDER system option when you start the SAS System. For more
information, see “SASINITIALFOLDER” on page 370

Opening Files

To open a file from the Program Editor,

1 With the Program Editor window active, either click on the Open toolbar button
(the opened file folder), type dlgopen in the command bar, or select the File
menu and select Open. SAS displays the Open dialog box.

2 Use the Open dialog box to select the file that you want to open. By default, SAS
looks for files with the .SAS file extension (which contain SAS code, by convention).

3 If the file that you are opening contains SAS code that you want to submit, check
the Submit box before clicking on OK .



30 Opening and Saving Files 4 Chapter 2

Note: If you check Submit, it remains checked and in effect each time you use
the Open dialog box to open a file. You must uncheck it if you do not want to
submit the contents of the file that you want to open. 4

You can also drag and drop a file into the Program Editor from the My Favorite
Folders window. To do this,

1 Open the My Favorites Folder window by selecting

View I My Favorite Folders

2 Position the My Favorite Folders window and the Program Editor window so that
both are visible.

3 In the My Favorite Folders window, find and select the file that you want to open;
click and hold down the right mouse button.

4 Drag the file over the Program Editor window and release the right mouse button.

Note: The Program Editor window can hold up to 256 characters on a single line. If
you open a file with lines longer than 256 characters in the Program Editor window, the
lines are truncated unless you issue the INCLUDE command with an LRECL= value
equal to the number of characters in the longest line, and you set either the
AUTOWRAP or AUTOFLOW command to ON. If you want to use the Open dialog box
to open a file with lines that are longer than 256 characters, use the FILENAME
statement to set up a fileref with the appropriate options and then include the fileref,
enclosed in double quotes, in the File Name field in the Open dialog box. 4

Saving Window Contents to a File
To save the contents of the active window to a file,

1 Either click on the Save toolbar button (the diskette) or select Save from the File
menu. If you have previously saved the contents of this window to a file (and the
filename is part of the window title), SAS simply saves the window to the file that
you specified previously. If you have not saved the document during this session
(and the window title bar displays the name “Untitled”), then SAS displays the
Save As dialog box.

If you have previously saved the editor contents but now want to save it to a
different file, select Save As instead of Save in the File menu or issue the
DLGSAVE command.

CAUTION:
Always use Save As when you want to save the contents of the editor window to a
new file. If you open a text file in the editor window, whether you use the Open
dialog box or the INCLUDE command, the editor title bar displays the name of
the file that you opened. When you select

File I Save

SAS overwrites or appends the file of that name with the current contents of the
editor. 4

2 Select Save As from the File menu and select or name the file where you want
to store the window contents.

Clearing the Window and Filename
To clear a SAS window of its contents and its saved filename (if it has one), do one of

the following:
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� press CTRL + E
� select Clear All from the Edit menu
� click on the New (the blank page) toolbar button
� select the File pull-down menu and select New
� type clear in the command bar and press ENTER.

If the contents of the window have not been saved, SAS prompts you to save them
before it clears the window.

Defining Keys
To display the key definitions that are active for the SAS session (that is, the

DMKEYS entry in your SASUSER.PROFILE catalog), either type keys in the command
bar or select

Tools I Options I Keys

These key definitions apply to the basic SAS windows, such as the Program Editor,
Output, and Log windows. “Default Key Definitions under OS/2” on page 409 contains a
list of the default key definitions.

Other SAS products have their own key definitions. Use the menus in the specific
product window to access key definitions for specific products.

Although the SAS System lets you define any key that is listed in the KEYS window,
OS/2 reserves some keys for itself to maintain conformity among OS/2 applications.
These reserved keys are not shown in the KEYS window.

To define or redefine a key within the SAS System, place the cursor in the
Definition column across from the key or mouse button that you want to define and
type the command or commands that you want to associate with that key or button.
The definition must be a valid SAS command or sequence of commands. When you
specify a sequence of commands, separate the commands with a semi-colon ( ; ). For
example, if you want to define the CTRL+H key sequence to maximize a window and
recall the last submitted program, specify the following commands in the Definitions
column next to CTL H:

zoom; recall

The SAS System does not check the syntax of a command until it is used (that is,
when the key is pressed). If you misspell a command or type an incorrect command,
you do not discover your error until you use the key and receive an error message that
indicates that the command was unrecognized.

Your key definitions are stored in your SAS user profile catalog. SAS creates a new
profile catalog each time you invoke the SAS System with a different value for the
SASUSER option. Changes that you make to one profile catalog are not reflected in any
other. However, you can use the COPY command from the KEYS window or the
CATALOG procedure to copy key definition members to other profile catalogs. (For
more information, see the CATALOG procedure in SAS Procedures Guide.)

Accessing Online Help and Documentation
The SAS System for OS/2 provides comprehensive HTML-based online

documentation. You can access several different levels of Help information, depending
on the context and the type of information that you need. Help information appears in
the Web browser that is specified in the Preferences dialog box Web page. For
information about defining a preferred browser, see “Web Preferences” on page 46.
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Getting Help from the Command Bar
You can get help for SAS language elements and SAS products by using the HELP

command in the command bar. When you issue the HELP command, the SAS System
Help displays Help for either the active window or for the type of Help that you specify
in the HELP command argument. Table 2.1 on page 32 lists the HELP command
arguments and the resulting display in the SAS online Help.

Table 2.1 Types of Help Available by Using the Command Bar

Help Argument The SAS System Help
Display

Example

none Help for the active window HELP

language element Help on the specified language
element

HELP FILENAME

language element type a list of links to all language
elements within the language
element type

HELP DSOPTIONS

product name product Help HELP SAS/CONNECT

HELP how to use the HELP command HELP HELP

The HELP arguments for language element types include these strings:

commands lists SAS commands

dsoptions or
datasetoptions

lists SAS data set options

formats lists SAS formats

functions lists SAS functions

informats lists SAS informats

procedures lists SAS procedures

statements lists SAS statements

systemoptions lists SAS system options

Getting Help in the Dialog Boxes
To access Help in a dialog box, click on the Help button in the dialog box or press

F1. A Help window opens that describes each item in the dialog box.

Getting Help for a SAS Product
To access Help information about the SAS product that is associated with the

currently active window, click on the Help toolbar button (the book with the question
mark), press the F1 function key, or select Using This Window from the Help menu.
(For example, if you click on the Help toolbar button and the active window is
a SAS/GRAPH window, the SAS online Help displays information about SAS/GRAPH
software.)



Using the SAS System Interface 4 Using the SAS Text Editor Windows 33

You can also get Help for a SAS product by issuing using the HELP command in the
command bar. When you use the product name as an argument to the HELP command,
the SAS Online Help displays the product help. For example, if you typed
help SAS/GRAPH in the command bar, the SAS System Help will open to the SAS/
GRAPH help.

Getting Help from the Help Menu
The Help menu is always available within your SAS session. Here are descriptions of

the topics that are available from the Help menu:

SAS System Help
comprehensive SAS language and option information, including information that
is specific to OS/2.

Using This Window
information that is relevant to the currently active window. This is the same as
clicking on the Help toolbar button or pressing the F1 key.

Books and Training
can provide access to SAS HTML-based books and tutorials that are available on
CD-ROM. The SAS Online Tutor is a separately licensed SAS product. In order to
use this menu selection to access the SAS online documentation and SAS
OnlineTutor, modify the DOCLOC and TRAINLOC system options in the SAS
configuration file to reflect the location of their respective folders.

Getting Started with SAS Software
provides a link to a tutorial on the SAS Web site that will help you get started
with SAS.

SAS on the Web
provides links to useful areas on the SAS Web site, including technical support,
frequently asked questions, sending feedback to SAS, and sample code.

Getting to the SAS Web Pages (and Others) from within the SAS System
The SAS System is configured to launch your local Web browser to view HTML files.

You can invoke your Web browser in either of the following ways:
� Type a URL (uniform resource locator) in the command bar. The SAS System will

launch the browser that you specified in the Preferences dialog box Web page.
� Issue the WBROWSE command, which will launch the browser with the SAS Web

site or another default URL that you can specify in the Preferences dialog box Web
page. For more information, see “WBROWSE” on page 220.

Note that you can access Web pages on the Internet (such as the SAS Web site) only
if your workstation is connected to a network that allows such access.

Working within Your SAS Session

Using the SAS Text Editor Windows
The SAS text editor windows (including Program Editor and NOTEPAD) work

similarly to other OS/2 editors. Thus, you can edit your SAS code without learning how
to use a new text editor.
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Using Line Numbers
If you are familiar with the SAS Program Editor window under other operating

environments such as OS/390 (formerly MVS), notice that under OS/2 line numbers are
turned off by default. You can issue the NUMBERS ON command from the command
bar to display line numbers in the Program Editor window.

You can also control line numbers by using the Editor Options dialog box when the
Program Editor or NOTEPAD is the active window. To open the Editor Options dialog
box:

1 Type EDOP in the command bar or select

Tools I Options I Editor

2 Click on the down-arrow in the drop-down list box and select Text Editing
Options.

3 Select Nums, click the right mouse button, and select Modify.
4 In the Value combo box, select either Yes or No and click on OK .

Moving the Cursor
The cursor movement keys (arrow keys, PgUp, PgDn, and so on) function the same

way in SAS text windows as they do in other OS/2 applications.
Pressing the CTRL key with the left arrow key (word left) or right arrow key (word

right) causes the cursor to move one word at a time. When you advance through text,
the word-left and word-right commands stop at the end of the text on a line and at the
beginning of the first word on a new line. You can move to the top of a file by pressing
CTRL+PgUp or to the bottom of a file by pressing CTRL+PgDn.

Pressing the Home key causes the cursor to move to the beginning of the current line
unless the command line is active. Pressing the Home key when the command line is
active causes the cursor to toggle between the current cursor position in the text and
the command line. The F11 key moves the cursor to the command line. You can toggle
the command line on and off by using the COMMAND command or by selecting
Command line in the Preferences dialog box General page.

Using Tabs
Many text editors retain tab characters, while others expand tabs into space

characters. The SAS Program Editor window expands tabs into space characters.
Pressing the TAB key inserts spaces and moves any text to the right of the cursor.

Understanding Line Breaks
Conceptually, line breaks are at the end of the line rather than at the beginning.

Pressing ENTER creates a line break. To delete a line break, press the Backspace key
at the beginning of a line or press the Delete key at the end of the line.

Selecting Text
You can use the mouse or the Shift key in combination with the cursor movement

keys to select text. The marking of an area of text continues until you release the
mouse button or release the Shift key. To select all of the text in the active window,
select Select All from the Edit menu. The following are several advanced text
selection methods:

� Double-click on a single word to select it. To select an entire line, hold down the
CTRL key as you double-click on the line you want to select.
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� Press and hold the ALT key while you click and hold the left mouse button and
drag the mouse to select a rectangular block (or column) of text (as shown).

� Use the Shift key in combination with the mouse button to select the text between
the current text cursor and the position in the text where you click. You can also
use this technique to extend a text selection. (You can use this feature only within
the current page.)

If characters are selected and you start typing text, the marked area is replaced with
the new text. This occurs even if you have moved the cursor away from the marked
area. For information about marking and copying text with a mouse, see “Using the
Clipboard” on page 37.

To unmark text, click the left mouse button in the window. Alternatively, you can
unmark text by selecting Deselect from the Edit menu, or you can press the ESC key.
You can also unmark text using the up, down, left, and right arrow navigation keys if
Enable unmarking with navigation keys is selected in the Preferences dialog box
Edit page. Entering the WNAVKEYUNMARK ON in the command bar also enables
unmarking with the arrow navigational keys.

Deleting Text
The Delete key deletes the currently selected text; otherwise, it deletes the character

to the right of the cursor. To delete from the cursor to the end of the current line, press
ALT+DELETE. To delete from the cursor to the end of the current word, press
CTRL+DELETE. To delete from the cursor to the start of the current word, press CTRL
+ BACKSPACE.

You can also use the Edit menu to delete text. To delete all text in the window, select
Clear All. To delete only selected text, select Clear. To delete selected text and copy
that text to the OS/2 clipboard, select Cut.

Dragging and Dropping Text
You can drag and drop selected text between the following locations:.
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Drag text from And drop it to

any SAS text window another SAS window that supports text editing
(such as Program Editor)

any SAS text window another OS/2 application that supports dragging
and dropping of text

an OS/2 application that supports text drag and
drop

any SAS window that supports editing

OS/2 Drives View (text file item) any SAS window that supports editing

To drag and drop text from one window to another:
1 Arrange your windows, if necessary, so that both the source and target windows

are visible on the display.
2 Select text from the source window.
3 Click and hold the right mouse button with the pointer on the selected text.
4 With the mouse button still pressed, drag the text to the target window.
5 Move the mouse pointer to the position where you want to insert the text. (If you

plan to just submit the text as SAS code for processing, position the mouse pointer
anywhere in the window.)

6 Release the mouse button. The text is either included at the point where you
positioned the cursor, or it is submitted to the SAS System for processing. (The
default action depends on the type of the target window.)

Here is a summary of drag-and-drop actions that are available for the possible target
windows in SAS:

Data Target

Default

Action

text SAS text editor move

text from Log, Output Program Editor, SAS text
editor

copy

file Program Editor copy

file Other SAS text editor windows not applicable

file Log,

Output windows

submit

The actions that occur when you drag text out of a SAS window into another OS/2
application depend on the target application. In most cases, dragging and dropping text
between SAS and other applications actually moves the text from one window to
another (that is, the text is cut from one window and placed in the other).

You can change that behavior by applying a drag-modifier—a key that you press
while you drag and drop. To copy text from one window to another (instead of moving
it), press and hold the CTRL key before and during the drag-and-drop action. When you
release the mouse button to drop the text, release the CTRL key as well.

Using Rich Text Format (RTF) Text
When you copy text out of a SAS window to the clipboard and paste it into the

window of another application, the text retains all of the format information that it had
in SAS (except for color) if the target window accepts RTF formatting. For example, the
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OS/2 System Editor does not preserve formatting, but the OS/2 Enhanced Editor and
many other word processors do. The same is true when you drag text out of a SAS
window and drop it in another application window.

Saving Program Editor Files Using Autosave
To be sure that you do not lose any of your work in the Program Editor, the SAS

System can automatically save your files at an interval that you specify. The interval
can range from 0 (Autosave off) to 480 minutes. The default interval is 10 minutes. To
enable or disable Autosave and set the interval, select

Tools I Options I Preferences... I Edit page

You can also use the WAUTOSAVE command to enable, disable, and set the interval.
WAUTOSAVE INTERVAL=minutes will turn on Autosave using minutes as the interval.

For more information about the Autosave feature, see “Edit Preferences” on page 45
and “WAUTOSAVE” on page 220.

Understanding Unique Features of the Editor
The following features of the SAS text editor window are different from the standard

features of other editors that are commonly used in the OS/2 operating environment:
� The SAS text editor window allows you to move the cursor past the last character

that is entered on a line or past the last line of text entered.
� You can unmark text by pressing the ESC key.
� You can use the SHIFT+TAB key combination to delete blank-space characters

back to the last tab stop.

Using the Clipboard
The OS/2 clipboard enables you to exchange text and graphics between applications.

You can also submit SAS code that is stored on the clipboard. The clipboard uses
operating environment memory as an intermediate storage buffer for exchanging text
and graphics. With the clipboard, you can move text between

� windows within the SAS System
� the SAS System and other OS/2 applications
� two SAS sessions
� two SAS processes.

The SAS System under OS/2 communicates with the clipboard by using these formats:

SAS text format
preserves the text and color attributes between SAS sessions. This format is
understood by the SAS System, but not by other OS/2 applications.

OS/2 text format
is understood by most OS/2 applications.

RTF text format
encapsulates text font and highlighting attributes when you are copying text
between applications that both support RTF format. SAS can cut and copy text
only in RTF format; you cannot paste RTF text into a SAS window.

bitmap format
is for graphics and for windows in SAS/ASSIST software. This format is
understood by most OS/2 applications.
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metafile format
is used in many SAS applications that support the GSTORE command, such as
the Graphics Editor in SAS/GRAPH software, the SAS/QC ISHIKAWA procedure,
and SAS/INSIGHT software. The metafile format that is supported for clipboard
operations has a file extension of MET and provides more information about the
image than about the bitmap format.

DIB (device independent bitmap) format
is used with color bitmap files. When a bitmap is stored in the DIB format, colors
map correctly from one device to another.

These formats enable you to copy text and SAS bitmapped information (for example,
from a graphic) to another application. You can also use the Print Screen and
ALT+PRINT SCREEN keys to copy information from your SAS session to the clipboard.
Pressing PRINT SCREEN places the entire display in bitmap form on the clipboard.

You can use the clipboard only if both the source and destination applications provide
support for the clipboard facility and for the format that you are using. Note that
whereas some operating environments allow multiple paste buffers, the SAS System
under OS/2 uses the OS/2 clipboard, which is a single buffer.

Selecting and Copying Text
For windows that contain text, such as the Program Editor, NOTEPAD, Log, Output,

and KEYS windows, you can hold down either the left mouse button or ALT + the left
mouse button and drag the mouse to mark the area that you want to cut or copy.
Holding down the left mouse button when you are selecting multiple lines selects whole
lines of text. Holding down ALT + the left mouse button lets you select a rectangular
block or column of text. The text area is immediately marked in reverse video while you
are dragging the mouse. To extend the selection of text area, use SHIFT + left mouse
button. Release the mouse button when you have included all the text you want to copy.

To copy marked text to the clipboard, do one of the following:
� click on the Copy toolbar button (the double document)
� select Copy from the Edit pull-down menu
� press CTRL + INS.

To paste text that is stored on the clipboard, position the cursor in a text area in a
window and do one of the following:

� click on the Paste toolbar button (the clipboard and document)
� select Paste from the Edit pull-down menu
� press SHIFT + INS.

The text from the clipboard is pasted to the area that you indicate. If there is already
an area of selected text within the target window, the selected text is replaced with
contents of the clipboard. You can paste text only into SAS windows that accept text
input, such as the Program Editor or the NOTEPAD.

Selecting and Copying in Nontext Windows
For windows such as the GRAPH and SAS/ASSIST windows, an area is marked by a

box, not by reverse video. The box indicates that the area that you are marking is in
bitmap format. You cannot scroll in these windows while you are marking text. After
you finish marking an area, you can copy it to the clipboard. If the window that you are
working in has no Edit pop-up menu, you can use the following keys to perform the
copy and paste functions:

CTRL+INS copies the selection to the clipboard.
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SHIFT + INS pastes the contents of the clipboard.

Using the GSTORE Command
Both the SAS/QC ISHIKAWA procedure and the Graphics Editor support the storing

of metafile graphics format as well as bitmap formats on the clipboard. In the Graphics
Editor, the area that you mark is enclosed in a box, and you cannot scroll as you mark.
Use the GSTORE command to store the currently marked area (the entire screen when
used with the ISHIKAWA procedure) on the OS/2 clipboard in device-dependent bitmap
(BMP) graphical data formats. You can also select Copy from the Edit menu to store
the marked area on the clipboard.

Pasting Bitmapped Information into Your SAS Session

You can paste bitmaps into the Graphics Editor and Image Editor to import graphics.
For more information, see “Importing Graphics from Other Applications” on page 115.

Submitting SAS Code from the Clipboard
The SAS System under OS/2 enables you to use the OS/2 clipboard to submit SAS

code. This feature can be used to copy or cut SAS code from another application, such
as the OS/2 Enhanced Editor or another text editor, and submit it to the SAS System
for execution. This is also convenient for submitting the sample programs that are
available in the SAS System Help.

To submit SAS code stored on the clipboard, select Submit Clipboard from the Run
menu with the Program Editor window active. Alternatively, you can issue the
GSUBMIT command from the command bar as follows:

gsubmit buf=default

The GSUBMIT command can be used to submit SAS code that is stored on the
clipboard even if the Program Editor window is not the active window (or if it is closed).
If you use the GSUBMIT command often, you may want to define an icon for it in the
toolbar, or assign the GSUBMIT command to a function key. For more information
about how to define toolbar buttons, see “Customizing the Toolbar” on page 50.

Creating Text Highlighting and Special Characters

Special Character Attributes
Both SAS NOTEPAD and SAS/AF allow you to use extended color and highlight

attributes for text. To access these attributes, press the ESC key and the appropriate
letter or number to turn a color or attribute on and off. With this feature, you can alter
the color or attributes of entire lines or individual words or letters. Valid colors and
attributes, as well as the keys you use to implement them, are listed in Table 2.2 on
page 40 and Table 2.3 on page 40. Color names are not case-sensitive.



40 Issuing SAS Commands 4 Chapter 2

Table 2.2 Extended Color Key Sequences

Key

Sequence Color

Key

Sequence Color

ESC+A Gray ESC+N Brown

ESC+B Blue ESC+O Orange

ESC+C Cyan ESC+P Pink

ESC+G Green ESC+R Red

ESC+K Black ESC+W White

ESC+M Magenta ESC+Y Yellow

Table 2.3 Extended Attribute Key Sequences

Key

Sequence Description

ESC+0 Turns off all highlighting attributes

ESC+2 Turns on the underline attribute

ESC+3 Turns on the reverse-video attribute

Alternate ASCII Characters
If you want to create alternate ASCII characters such as foreign language

characters, you can use the ALT key in combination with the ASCII character code. Use
the numeric keypad with NumLock on to enter the character code. For a list of ASCII
character codes and instructions about how to use the ALT key sequences, see your
OS/2 documentation.

Issuing SAS Commands

Using Menus to Issue Commands
Many commands are already assigned to menu items for the windows in which they

apply. For example, selecting Submit from the Run menu for the Program Editor
window has the same effect as typing submit at the Program Editor command line.
The items in the menu bar and pop-up window vary depending on the active window.

Using the Command Line to Issue Commands
If you want to use the command line to issue commands, select Command line from

the Preferences dialog box View page. (For more information, see “Setting Session
Preferences” on page 43.) This action places a command line in each SAS window. You
can then type commands on the command line in the window in which the commands
apply. (For example, the INCLUDE command is valid in the Program Editor window,
but not in the Log window.)
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Using the Command Bar or the Command Box to Issue Commands
The command bar and the command box offer a central location from which you can

submit any SAS command, as long as the command is valid for the active window. If you
enter a command that is not valid for the active window, SAS issues an error message.

By default, SAS displays a command bar at the top of the main SAS window. You can
also undock the command bar and use it in a separate window. To undock the command
bar:

1 Position the cursor over the command bar (not in the text field)

2 Click the right mouse button and select Docked.

To dock the command bar again:

1 Position the cursor over the command box (not in the text field)

2 Click the right mouse button, and select Docked, or double-click the left mouse
button in the command box title bar.

To move your cursor to the command bar, press the F11 key. Pressing F11 when you
are using the command box docks the command box and places the cursor in the
command bar.

The SAS System stores the commands that you enter in the command bar from
session to session, and you can easily retrieve previously entered commands by
selecting them from the drop-down list. The default number of commands to save is 15,
but you can save from zero to 50 commands. SAS can store the commands either in
order of the most recently used or in order of the most frequently used. To store the
commands by the most recently used, select Sort commands by most recently used
in the Customize Tools Toolbar page. When this option is not selected, the commands
are sorted by the most frequently used.

You can also retrieve previously entered commands by starting to type them in the
command bar. If Use AutoComplete is selected in the Customized Tools Toolbar page,
the SAS System completes the command that best matches the command that you are
typing.

You can select your preferences for the command bar by using the Customize Tools
dialog box (described in “Setting General Toolbar Preferences” on page 50). To open the
Customize Tool dialog box, issue the TOOLEDIT command (described in “TOOLEDIT”
on page 216) or select

Tools I Customize...

Using the Toolbar to Issue Commands
The toolbar provides a convenient way to issue commands that you use often. To

issue a command by using the toolbar, simply click on the icon that represents the
command that you need. To learn which tools perform what commands, position the
mouse pointer over a tool briefly to display the screen tip for that tool.

When you start the SAS System, the toolbar displays at the top of the main SAS
windows. You can detach the toolbar and use it in a separate window by

1 positioning the cursor over the toolbar (not over a tool)

2 clicking the right mouse button and selecting Docked.

You can dock the toolbar again by

1 positioning the cursor over the toolbar (not over a tool)

2 clicking the right mouse button and selecting Docked or double-clicking the left
mouse button in the toolbar title bar.
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You can add or change the tools that are defined in the toolbar. For more
information, see “Customizing the Toolbar” on page 50.

Changing the SAS Current Folder
The current folder is the operating environment folder in which many SAS

commands and actions are valid. The path to the SAS current folder is displayed in the
status line at the bottom of the main SAS window. By default, the SAS System uses the
folder that is designated by the SASUSER system option in the SAS configuration file
as the current folder when you begin your SAS session. You can specify a different
default current folder by changing the Working directory field in the Properties
Program page for the SAS program or by specifying the SASINITIALFOLDER system
option during SAS invocation. For more information on the SASINITIALFOLDER, see
“SASINITIALFOLDER” on page 370.

Interactively Selecting a New Current Folder
To change the SAS current folder during your SAS session, double-click on the

current folder in the status line. Then use the Change Folder dialog box (shown in
Display 2.2 on page 42) to select a new working folder.

Display 2.2 Change Folder Dialog Box

If you organize your files so that each project has its own folder, then the Change
Folder dialog box allows you to quickly switch between projects. As you select different
projects, the dialog box retains the directories that you select in the Folder list box.

Using SAS Statements to Change the Working Folder
You can change the working drive and folder by submitting the change directory (CD

or CHDIR) command with the X statement in SAS. The SAS System intercepts the
change directory command and then changes drive commands and changes its working
folder.

For example, the following statements change the working folder for your SAS
session to the MYDATA folder and G:\SALES\JUNE folder, respectively:

x ’cd \mydata’;
x ’cd g:\sales\june’;
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To simply change the working drive, you can submit a change drive command (the
drive letter followed by a colon and enclosed in single quotes) such as the following:

x ’a:’;

Customizing Your SAS Session

The SAS windowing environment can be customized in several ways by using
commands, dialog boxes, and SAS system options.

Selecting Fonts
To choose a different font or point size for text in SAS windows, open the Fonts

dialog box by selecting

Tools I Options I Fonts

The fonts that are available depend on which monospace fonts you have installed under
OS/2. For example, you might have the Courier font available. When you select a font
or point size, the Font Sample field displays a sample of the font that you have selected.

Note: You cannot use Fonts to select SAS/GRAPH fonts. 4

CAUTION:
Beware of changing certain display characteristics on low-resolution displays. If you select
large font sizes on some monitors, you may not be able to see all the text in your SAS
windows at one time. In some windows, such as the SAS/ASSIST window where
there are no scroll bars, large font sizes can cause some choices to be invisible. For
these types of displays, large font sizes are not recommended. This same problem
can occur if you change the OS/2 Appearance properties and select a thick window
border. On low-resolution displays, you should not use thick window borders. 4

Setting Session Preferences
You can configure your SAS session to accommodate the way that you like to work.

For example:

� You can use a movable command window instead of the command bar.

� You can set preferences for scrolling behavior and window appearance.

� You can set a preferred Web browser to use when viewing Internet Web pages or
HTML output.

To set your preferences, type dlgpref in the command bar or select

Tools I Options I Preferences...

The Preferences dialog box (shown in Display 2.3 on page 44) contains different pages
that separate the session settings into different categories. Click on the tabs for each
page that are located along the top of the dialog box to navigate to the settings that you
want to change, and then select the options that you want. When you are finished, click
OK . The settings that you select are saved from session to session in the
SASUSER.PROFILE catalog by their respecitve pages except for the Results page.
The entries in the SASUSER.PROFILE are GENWSAVE, VIEWWSAVE, EDITWSAVE,
WEBWSAVE, and ADVWSAVE. The Results page settings are saved in the SAS
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Registry so they are not moved to another machine when the SASUSER.PROFILE
catalog is copied.

Display 2.3 Preferences Dialog Box (Showing the General Tab)

The following sections describe each page of the Preferences dialog box and how to
use these settings to control your SAS session.

General Preferences
The General Preferences page lets you specify the general options that control how

your SAS session works. These are the general options:

Recently used file list
specifies whether SAS retains a list of the files that you have accessed. If this
option is selected, you can specify in the Entries field up to 30 files that you want
to retain. Show recently used file list on submenu specifies whether the
files will be displayed from the Recent Files submenu that you access from the
File menu. If Show recently used file list on submenu is not selected, the
files are displayed in the File menu. Each time that you access a file from a text
editor window, the filename is added to the list. You can then reopen the file
quickly by selecting the filename from the list.

Confirm exit of SAS
specifies whether you want the SAS System to prompt you for confirmation before
you end your SAS session.

Save settings on Exit
specifies whether SAS should automatically save your settings when you exit your
SAS session.
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Submit contents of file opened
specifies whether you want to submit the contents of all files that you open to the
SAS System.

Mail current window as attachment
specifies whether the active window should be automatically included as an e-mail
attachment when you initiate electronic mail from within SAS. If you select this
option, then you can also specify whether the attachment should be formatted as
plain text or as RTF (rich text format, which retains font and color information).

View Preferences
The View page allows you to specify the options that control the appearance of your

SAS session. The view options include the following:

Window
specifies whether your SAS windows contain scroll bars and a command line. You
can also enable or disable a ScreenTip (the helpful hints that appear when you
position your mouse pointer over window controls).

Show
specifies whether to show certain aspects of the SAS interface, including these
options:

Docking View
specifies whether to display the docking area on the left side of the main SAS
window.

Status line
specifies which aspects of the status line you want to have visible in your
session. Display message lines specifies whether to display the message
area of the status line. Display current folder specifies whether to
display the SAS current folder area.

Edit Preferences
The Edit page controls options that affect the SAS text editor include the following:

Overtype mode
specifies whether to insert text or overtype on existing text when you type text in
a SAS application window. You can also toggle the overtype mode by pressing the
INSERT key on your keyboard.

Enable unmarking with navigation keys
enables unmarking of text using the up, down, left, and right navigation keys.

Autosave every n minutes
specifies whether to automatically save the contents of the Program Editor, and
how often to save it. The contents are saved to PGM.ASV in the current active
folder so that you can recover your work if your SAS session ends before you save
the contents of the editor window.

Results Preferences
The Results page allows you to configure how you would like to view your program

output results. The Results page options include the following:
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Create listing
specifies that the program output is to be displayed in the Output window.

Create HTML
specifies that the program output is to be displayed in HTML format.

Style:
allows you to choose the appearance of the program output. For more
information, see the topic on customizing the styles used in HTML output in
the SAS online Help.

Folder:
specifies a folder to store HTML output files. You can either type a folder
name or click on Browse to search for a folder.

Use WORK folder
specifies to store HTML program output files in the WORK folder. The WORK
folder is a temporary folder that is deleted when the SAS session ends.

View results as they are generated
specifies whether to update the browser with the latest generated HTML
output.

Web Preferences
The Web Preferences page allows you to specify the preferred Web browser for your

SAS session. These preferences are used whenever you issue the WBROWSE command
(either directly or by selecting a Help menu item or toolbar button that issues the
command). For more information about WBROWSE, see “WBROWSE” on page 220.
The Web options that you can specify are

Preferred browser
specifies the preferred Web browser to use when accessing Web information from
within the SAS System. Type a path to the Web browser or click on Browse to
search for the path to the Web browser.

Start page
specifies the default Web page to which to navigate when you invoke the Web
browser within the SAS System. By default, the browser navigates to http://
www.sas.com (the SAS Institute home page on the World Wide Web).

Advanced Preferences
The Advanced Preferences page allows you to specify options that can affect your

SAS session, including scrolling policy and other miscellaneous behavior. The advanced
options include

Scrolling Options
For the Output window, if Scroll lines is selected and the window is full, the
window will scroll the number of lines that are specified in the spin box. The
default value is 0 (meaning that no output is written to that window while
statements are executing, providing the best performance). When you select
Scroll page, the Output window will not display any lines until an entire page is
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written. When Scroll max is selected, no output will be written to the window
until the procedure is complete.

The default Scroll lines value for the Log window is 1. The advantage of
keeping the scrolling setting of the Log window at 1 is that the SAS System uses
the Log window to notify you of the status of the running program.

Scrolling can increase the length of time that the SAS System takes to run your
program. The less scrolling that is required, the faster your program will run.

You can also set these values by using the Editor Options window or the
AUTOSCROLL command (described in the SAS online Help).

Hide cursor in non-input windows
specifies that the cursor will not appear in windows that do not require text input
(such as some SAS/AF programs and SAS/ASSIST software).

Disable scroll bar focus
specifies that the scroll bar does not receive window focus when you click on it.
This eliminates flashing problems that can occur in some SAS applications.

Customizing Your Windowing Environment
You can use several commands to customize your SAS windowing environment. This

section illustrates how to use some of these commands.

Customizing Window Positions
In the default display configuration of an interactive session (shown in Display 2.1 on

page 27) the main SAS window displays the Explorer and Results windows as docked
windows, and the Log, Program Editor, and Output windows in the remaining SAS
workspace.

Using the Window menu, you can position SAS windows in the same manner as other
OS/2 applications: Minimize (Restore) All Windows, Cascade, Tile, and Resize.
While the default display configuration is sufficient for efficient SAS System use, you
may want to open a few more windows for easy access and rearrange the windows on
your display. For example, you may want the My Favorite Folders window open, but
minimized, with the windows arranged in a mosaic pattern so you can see all of them at
once. To accomplish this, you click on the minimize button in the window title bar for
the My Favorite Folders window and then select Tile from the Window menu.

For more information about SAS commands that have OS/2 dependencies, see “SAS
Commands under OS/2” on page 196.

Changing the Window Colors
Changing the color of window components is a shared responsibility of OS/2 and the

SAS System. You change the color of most standard window parts by changing the
Properties of the OS/2 desktop.

Note: For optimal color resoultion when running OS/2 in 256 colors, check the
“Workplace shell palette aware” check box in the System Properties notebook 256
Colors tab. To open the System Properties notebook from the desktop, double-click on
the following icons:

OS/2 System I System Setup I System

4
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Several window element colors are controlled by the SAS System (such as the color of
error message text in the Log window). To change a window component that is
controlled by the SAS System, either type SASCOLOR in the command bar or select

Tools I Options I Colors

The SASCOLOR window allows you to choose the colors for specific elements. For more
information about the SASCOLOR window, see the SAS System Help for the window.

Customizing Your Windowing Environment with System Options
Several SAS system options are available to control the default windowing

environment within the SAS System. The most commonly used options are the
following:

AWSDEF
specifies the location and dimensions of the main SAS window when the SAS
System initializes.

AWSTITLE
specifies the text for the main SAS window title bar.

FONT
specifies a font name and point size to use as the default SAS session font.

ICON
minimizes the SAS window when the SAS System initializes.

REGISTER
enables you to add applications to the SAS Tools menu so that you can execute
them by clicking on their names.

SPLASHLOC and NOSPLASH
specifies the location of the logo screen (SPLASHLOC) to display at the start of a
SAS session, or suppresses the logo screen (NOSPLASH).

USERICON
specifies user-defined icons to be incorporated into SAS/AF applications.

These options can be specified in your SAS configuration file or in the SAS command
when you start the SAS System from an OS/2 window. Some are also valid in an
OPTIONS statement. For details about the syntax of these options and about where
you can specify them, see “SAS System Options under OS/2” on page 313.

Changing the Size and Placement of the Main SAS Window
The AWSDEF system option enables you to control the placement and size of the

main SAS window when the SAS System initializes. Suppose you want your SAS
session always to occupy the upper-left quadrant of your display. To accomplish this,
specify the following AWSDEF system option in your SAS configuration file:

-awsdef 0 0 50 50

For more information about the AWSDEF system option, see “AWSDEF” on page 327.

Changing the Title of Your SAS Session
By default, the main SAS title bar contains the text SAS. If you want a different title,

you can use the AWSTITLE option. To set the title to My SAS Session, specify the
following option in your SAS configuration file:
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-awstitle "My SAS Session"

Minimizing Your SAS Session
The ICON system option causes the SAS System to be minimized at invocation. If you

are running a batch job, you might want to use this option to save space on your display.

Adding Applications to the Tools Menu
The REGISTER system option enables you to add names of applications to the Tools

menu of the main SAS window. You can execute one of these applications by clicking on
its name. The REGISTER option takes as arguments a menu name and an operating
environment command or a path specification for an executable file. You can also
specify a working folder. For complete information about the REGISTER system option,
see “REGISTER ”on page 363.

Here is an example that adds a command to print the contents of the SASUSER
folder:

-register "Contents of SAS"
"dir c:\sas"

When you select Contents of SASUSER from the Tools menu, the output from
issuing the OS/2 DIR command is displayed in an OS/2 window.

Here is an example of adding an .EXE file to the menu along with a specification of a
working folder of C:\NOTEDATA:

-register "Notes" "notes.exe" "c:\notedata"

This adds Notes to the menu. When you select Notes, the file NOTES.EXE is opened.

Note: The REGISTER system option is valid only as an invocation option (that is, in
a SAS configuration file and in the SAS invocation command). 4

Displaying a Custom Logo Screen during SAS System Invocation
To display your own logo when the SAS System starts

1 Create the logo that you want to display and either save it as a bitmap (which has
a .BMP file extension), or compile it as a resource and build it into a dynamic link
library (DLL).

2 When you invoke SAS, specify the SPLASHLOC option with the full pathname of
the file that contains your bitmap. If the bitmap is in a DLL, specify the resource
number as well. The default resource number is 1.

For example, suppose your logo screen is stored in C:\MYBMPS\SPLASH.BMP. You
specify the SPLASHLOC option like this:

-splashloc c:\mybmps\splash.bmp

If your logo were stored in C:\MYDLLS\OPENING.DLL as resource 101, you would
specify the SPLASHLOC option like this:

-splashloc c:\mydlls\opening.dll 101

For more information about the SPLASHLOC system option, see “SPLASHLOC” on
page 375.

Adding User-Defined Icons to the SAS System
The USERICON option enables you to add your own icons to the SAS System. These

icons can be used in SAS/AF and SAS/EIS software. The syntax for the USERICON
option is as follows:
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-USERICON icon-resource-file number-of-icons

The icon-resource-file argument specifies the full path to a dynamic link library
(DLL) file that contains the user icons. The number-of-icons argument specifies the
number of icons that are found in the resource file. For example, the following option
specifies that there are four icons located in an icon resource file named ICONS.DLL
found in the C:\JUNK folder:

-usericon c:\junk\icons.dll 4

The DLL that is used as the icon resource file must be created using the OS/2
Software Development Kit (and must therefore be 32-bit). For more information about
how to build a resource file, see the documentation for the OS/2 Software Development
Kit.

You can incorporate icons into your SAS/AF and SAS/EIS applications by using a
FRAME entry. For more information, see the SAS online Help for SAS/AF and SAS/EIS
software.

Customizing the Toolbar

SAS assigns several commonly used commands to the toolbar buttons for your
convenience. You might find that the commands that you use most often are different
from those that are assigned to the toolbar by default. Or, you might want to create a
toolbar to use with a specific application window or SAS/AF program. This section
describes how to customize the toolbar settings.

You customize all toolbar settings using the Customize Tools dialog box. To open the
Customize Tools dialog box, either type tooledit in the command bar or select

Tools I Customize...

You use the Toolbars page for general toolbar settings and the Customize page to
define tools on the toolbar.

Setting General Toolbar Preferences

The Toolbars page has settings that control the behavior and appearance of the
toolbar. Tools options include

General
specifies toolbar button appearance and Help options. These options include

Large icons
specifies whether to use the set of large buttons on the toolbar. This is
especially useful for high-resolution displays.

Show ScreenTips on toolbars
specifies whether to display a short button description when you place the
cursor over the toolbar button.

Toolbars
specifies whether to display the toolbar and command bar. These options include

Application Toolbar
specifies whether to display the toolbar for the active application. When this
option is enabled, you can select Display as box for the toolbar to display in
a separate window. Otherwise, the toolbar is docked to the main SAS window.
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Command Bar
specifies that the command bar is to be displayed and the options be enabled
in order to use the command bar.

When Display as box is enabled, the command bar displays as a
separate window.

When Use AutoComplete is enabled, SAS remembers previously entered
commands and completes the command once you start typing the
command.

Select Sort commands by most recently used to display commands in
the command bar drop-down list in the order of the most recently typed
command. If this setting is not selected, the drop-down list commands
are ordered by the most frequently used.

In the Number of commands saved box, type the number of commands to
save to display in the command bar list box. Valid values range from 0
and 50. The default is 15.

When you have configured the Toolbars page, either click on Customize to complete
your customization or click on OK to close the dialog box.

Customizing a Toolbar
The Customize page allows you to add, delete, and modify commands on the toolbar.

Display 2.4 on page 51 shows the Customize page of the Customize Tools dialog box.

Display 2.4 Customize Page of the Customize Tools Dialog Box

You may recognize some buttons as standard OS/2 commands, such as OPEN and
SAVE. The following section explains each of the buttons (commands) and fields.

The three toolbar buttons that act on the file that contains the toolbar definition are,
from left to right:

� the open button opens a toolbar file.
� the save button saves a toolbar file.
� the restore button restores a toolbar to the default settings.
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Title
displays the title text that appears in the title bar when the toolbar is undocked.

Commands to define a toolbar, a series of eight buttons from left to right:

Add a tool
adds a tool or a separator space to the toolbar. To add a tool or a separator,
click on the button and select either Blank tool or Separator. Windows
that already define an action set will have a selection for Action.

Remove tool
deletes a highlighted tool in the list box from the toolbar.

Change button
opens the Bitmap Browser to select a new icon for a tool button.

Move tool up
moves a tool up one position in the list box.

Move tool down
moves a tool down one position in the list box.

Cut
deletes the currently selected button from the list box and places it on the
clipboard.

Copy
places a copy of the selected button on the clipboard.

Paste
copies a button from the clipboard to the highlighted command in the list box.

Command
displays the command for the highlighted tool in the list box. You can then either
add or modify the command in the text box.

Help Text
displays the Help text that appears in the message area of the status bar when
the cursor is placed over the button in the toolbar. You can add to or modify the
Help text in the text box.

Tip Text
displays the tip text that appears under the button when the cursor is placed over
the button in the toolbar. You can add to or modify the tip text in the text box.

Toolbar list box
lists the buttons, commands, Help text and separators that are defined in the
toolbar.

To close the dialog box, click on OK .

Adding a Tool to the Toolbar
To add a tool to the toolbar, follow these steps:
1 Do one of the following:

� Click on the Add tool button and select Blank Tool to add a blank tool to the
toolbar list box. Type a SAS command in the Command field.

� For windows that have a predefined set of tools, such as the SAS Explorer
window or the My Favorite Folders window, click on the Add tool button and
select Action. From the Add Action dialog box, select an action. This adds a
new action to the toolbar. You can type multiple commands separated by
semicolons.



Using the SAS System Interface 4 Customizing and Saving a Toolbar 53

� Click on the Add tool button and select Separator to add a separator to the
toolbar.

2 Click on the Bitmap Browser button. Select a button in the Bitmap Browser dialog
box and click on OK .

3 Type text in the Help Text field that will appear in the message area of the status
line when you select the tool from the toolbar.

4 Type text in the Tip Text field that will appear under the button when you place
the cursor over the button.

5 Position the tool in the list box by clicking on the Move Up and Move Down
buttons.

6 When you are finished, click on the Save button. In the Save Tools dialog box, type
the library, catalog, and toolbox names. Then click on OK .

Removing a Tool from the Toolbar
To remove a tool from the toolbar, select the tool in the list box that you want to

remove and click on the Remove Tool button. When you are finished, save the toolbar
by clicking on the Save button.

Customizing and Saving a Toolbar for Use with a Particular Application or
Window

Follow these steps to customize a toolbar for use with a particular application or
window:

1 Click in the application or window to make it the active window.

2 Customize the toolbar by adding and removing tools as described in previous
sections.

3 When you have finished customizing the toolbar, click on the Save button. The
Save Tools dialog box appears.

4 The SAS System completes the LIBREF, CATALOG, and ENTRY fields. Select the
Save tools for window check box, where window is the active window, and
then click on OK .

When you select the Save tools for window check box, the toolbar is
associated with the particular application or window by using the same library,
catalog, and entry name as the PMENU entry for the application or window. The
SAS System first looks for toolbox entries in SASUSER.PROFILE before searching
the application catalog.

If you save the toolbar so that it is associated with a particular application, SAS
automatically loads the tools when that application’s window is active.

You can use the TOOLLOAD command to load your custom toolbar manually. For
more information, see “TOOLLOAD” on page 217.

Resetting the Tools to the Default Settings
To reset the tools to the default settings, click on the Restore Defaults button. The

SAS System asks you to confirm that you want to reset the tool settings. When you
click on Yes , the tools are reset to their original settings (the settings that are in place
when the SAS System was installed).
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If a SAS System application defines a default toolbar for its application window,
clicking on the Restore Defaults button restores the settings for that toolbar.

Examples of Useful Tools You Can Create
To create a tool that opens the SAS online documentation (SAS OnlineDoc) follow

these steps:
1 In the Tool Editor dialog box, click on the Add tool button. This creates a template

for a new tool in the list box.
2 In the Command field, type sasdoc onlinedoc, which invokes the SAS OnlineDoc

product. For more information about SAS commands that are specific to OS/2 and
their options, see “SAS Commands under OS/2” on page 196. For information
about portable SAS commands, see the SAS online Help.

In the Help Text field, type Open the SAS OnlineDoc. In the Tip Text
field, type SAS OnlineDoc.

3 Click on the Bitmap Browser button. From the Bitmap Browser dialog box, select
a bitmap that is appropriate for the Help action (such as PC with text bitmap) and
click on OK .

4 Use the Move Up and Move Down buttons to move the tool to the location that you
want on the toolbar.

5 Click on the Save button to save the tool with your default tool configuration.

The following are some other tools that you might find useful to create.

PGM; CLEAR; INCLUDE C:\SAS\MYPROGRAM.SAS
includes into the Program Editor window for editing a program that you use often.

PGM; FILE C:\SAS\MYPROGRAM.SAS; CLEAR
saves a SAS program after you finish editing it and clears the Program Editor
window.

PGM; CLEAR; INCLUDE C:\SAS\MYPROGRAM.SAS; SUBMIT
includes and submits a SAS program that you use often.

PGM; CLEAR; INCLUDE C:\SAS\SIGNON.SAS; SUBMIT
includes and submits a SAS program to sign on to a remote system. For example,
to sign on to a remote MVS session, the SIGNON.SAS program might contain the
folowing statements:

options comamid=ehllapi remote=mytso;
libname remtdata ’mylib.mydata.monthly’;
signon;

For more information about signing on to remote sessions, see SAS/CONNECT
User’s Guide.

PGM; CLEAR; INCLUDE C:\SAS\DOWNLOAD.SAS; SUBMIT
includes and submits a SAS program to download a data set from a remote
session. Assuming that you have already signed on to the remote session,
DOWNLOAD.SAS might contain the following statements:

proc download data=remtdata.june;
/* where libname ’remtdata’ is */
/* already defined */

run;

For more information about signing on to remote sessions, see SAS/CONNECT
User’s Guide.

TOOLLOAD BAR SASUSER.PROFILE.MORTOOLS
loads a different toolbar (that you created) that contains another collection of tools.



The correct bibliographic citation for this manual is as follows: SAS Institute Inc., SAS ®

Companion for the OS/2 ® Environment, Version 8, Cary, NC: SAS Institute Inc., 1999.
448 pp.

SAS® Companion for the OS/2® Environment, Version 8
Copyright © 1999 by SAS Institute Inc., Cary, NC, USA.
ISBN 1-58025-521-3
All rights reserved. Produced in the United States of America. No part of this publication
may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, or otherwise, without the prior written
permission of the publisher, SAS Institute Inc.
U.S. Government Restricted Rights Notice. Use, duplication, or disclosure of the
software and related documentation by the U.S. government is subject to the Agreement
with SAS Institute and the restrictions set forth in FAR 52.227–19 Commercial Computer
Software-Restricted Rights (June 1987).
SAS Institute Inc., SAS Campus Drive, Cary, North Carolina 27513.
1st printing, October 1999
SAS® and all other SAS Institute Inc. product or service names are registered trademarks
or trademarks of SAS Institute Inc. in the USA and other countries.® indicates USA
registration.
IBM® and OS/2® are registered trademarks or trademarks of International Business
Machines Corporation. ® indicates USA registration.
Other brand and product names are registered trademarks or trademarks of their
respective companies.
The Institute is a private company devoted to the support and further development of its
software and related services.


